Nedjelja 3

Modeliranje grednih konstrukcija
konacnim elementima
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Postavka zadatka

Gredna konstrukcija prikazana na slici je
izradena od celicnih | profila (356x171x51).
Odrediti deformacije i napone konstrukcije na
koju djeluje kontinuirano opterecenje od q=50
KN/m kao na slici.
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Noseca konstrukcije mosta
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Modeliranje gredne konstrukcije

Aktivirati program ANSYS i sacuvati
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Modeliranje gredne konstrukcije

Kreirati  statiCku linearnu  analizu Static
Structural) na shemi projekta (Project Shematic
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Modeliranje gredne konstrukcije

lzvrsSiti podesavanja modula Design Modeler
(Geometry->Properties->Line Bodies = On

I\ Resetiasta konstrukdija - Workbench

Q Engineering Data ' pl Fle Edt Vew Toos Unts Exensions Help
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Modeliranj

e gredne konstrukcije

Aktivirati modul Design Modeler (Geometry-
>New Geometry)

A
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Modeliranje gredne konstrukcije

Podesiti duzinske jedinice (Units->Meter)

&) A: Static Structural - DesignModeler
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Modeliranje gredne konstrukcije

Podesiti parametre mreze | skokovitog kretanja
(Sketching->Settings->Grid) (Show in 2D = On)
(Snap = On)

@50 A: Static Structural - DesignModeler £D - sse situtal -Desiiniadelet - x
| File Create Concept Tools Units View Help
| File Create Concept Tools Units View He |2 EHBE ||| Dunde @redo [[select[y G- [ W@ MW (& | M8 ||SHQAQAQBAQ AL |G [0 W Wy £+ A~ f fr fo A 5
2 - - | xvPiane v % | None « #9 || fGenerate W hae Topcion,  [EE]Parameters
| “4 g | @ | G;‘;: Undo C-“ | Se | BEbtude @oRevolve QoSweep 4§ Skin/Loft || @Point E)Conver ] WThin/Sutace. W Blend ~ % Chamfer @S
. J e Sketching Toolboxes 7 Graphics 7
l XYPlane - *| MNone - zﬂ Draw
- 2 Modify A
Graph e i
Constraints
Draw Settings N
= i Grid
Modify ¥ Major Grid Spacing
- : 5 Minor-Steps per Major
Dimensions 4 Snaps per Minor [ — RETEls el 80 8 I B e i E
Constraints l ; : i i
Settings | = I
[E Grid Show in 2D: ¥ Snapi ¥ stetcing [moceing ] ;
B : — Details View 2 T
[§5 Major Grid Spacing 5m e 7
[ﬁMincr-StepsperMajor I5 en R ERE i T e siE ST i B T
@SﬂapsperMinn( K o e = : = — R !
s | | [
I I
L ) i 0 10,600 20,000 (m) |
: H —
¥ | | i il 5000 J 5000 i
Sketching | Modeling | 3 _Modetview [Print Preview |

| @ Grid - Set snaps per minor grid spacing

[No Selection

743 PM

) SR
G LT 4/25/2020

Studijski program Masinstvo — Konstruisanje pomocu racunara



Modeliranje gredne konstrukcije

Nacrtati konstrukciju (Sketching->Draw->Line)
okoncati crtanje skice komandom Generate
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Modeliranje gredne konstrukcije

Aktivirati opciju (Concept->Lines from Sketches)

@B) A: Static Structural - DesignModeler @ A Static Structural - DesignModeler

— X
| File Create Concept Tools Units View Help | File Create Concept Tools Units View Help
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Modeliranje gredne konstrukcije

Aktivirati opciju (Create->Body Transformation-
>Translation

@B A: Static Structural - DesignModeler
| File | Create Concept Tools Units View Help
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Modeliranje gredne konstrukcije

Podesiti

parametre

ranslate1)

@ A: Static Structural - DesignModeler
| File Create Concept Tools Units View Help
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Modeliranje gredne konstrukcije

Aktivirati opciju (Concept->Lines from Points)

&0 A: Static Structural - DesignModeler - X
File Create | Concept Tools Units View Help
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Modeliranje gredne konstrukcije

Dodati 6 uzduznih grede konstrukcije (izabrati
pocetnu taCku grede, a potom i krajnju uz CTRL)

le Create Concept Tools Units Help - B
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Modeliranje gredne konstrukcije

Iskljuditi

prikazivanje lokalnih

sistema (View->Cross Sections Alignments)

@ A: Static Structural - DesignModeler

- X
File Creste Concept Tools Units | View Help
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Modeliranje gredne konstrukcije

lzbor popreCnog presjeka (Concept->Cross
Sections->| Section

@0 A: Static Structural - DesignModeler L X
| File Create | Concept Tools Units View Help
| 2) bl | Lines From Poins et b BR85S+ QARQEAQCE 4G (2] B W- 4 4 4 f- - A #
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Modeliranje gredne konstrukcije

Podesavanje parametara poprecnog presjeka
(Details of 11)

@B) A: Static Structural - DesignModeler - X
| File Create Concept Tools Units View Help
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Modeliranje gredne konstrukcije

Dodjeliti poprecni presjek elementima
konstrukcije

@ A: Static Structural - DesignModeler

| File Create Concept Tools Units View Help
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Modeliranje gredne konstrukcije

UkljuCiti prikazivanje elemenata konstrukcije kao
punih tijela (View->Cross Sections Solids)

@ A: Static Structural - DesignModeler L X
| File Create Concept Tools Units |View Help
| 21 @ ||| Dunde CGFlv Shaded Eerior and Edges B o meS++Qaa@RaEahee M| B- -4/ L A f-AF
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Modeliranje gredne konstrukcije

8 zelenih elemenata konstrukcije treba zarotitat
za 90° kako bi se doveli u potrebni polozaj

@ A: Static Structural - DesignModeler
| File Create Concept Tools Units View Help

PN
| & || Dlnde GRedo ||Select:| h'\E‘, @@lw’i”ﬁlﬁ ESH-QAQARQQE 4 @le (/2] - W~ 4 4~ £ fr A~ A &
| xvPlane v ¥ | Sketcht ~ # || </ Generste @@Share Topology ~[FE]Parameters || ®roint E>Conversion || WEdrude @aRevolve QpSweep §Skinjloft || WMThin/ufsce QBlend v & Chornier @Slice
Tree Outline 3 Graphics 2
-8l A: Static Structural
By XYPlane
! 29 Sketchl
b ZXPlane
3 YZPlane
23 Linel
»a® Translate2
™ Line3
El-» @8 1 Cross Section
JEN
-8 1Part, 1 Body
™ Line Body

Sketching Moadeling

| Details Vi
|- | Line-Body Edges: 8

| Alignment Mode Tsaecion | [RRRER
Cross Section Alignment | Plan Normal
[atignment x o
[Aiignment Y lo | o
T———
| Reve: — i

_Model View [Print Preview |

| ) select aY-Axis direction for applying cross section data

e ® & € T @ w

8 Edges: Length = 48331 m [Meter Degree oo
623 PM
4/28/2020

d) @ SRP

Studijski program Masinstvo — Konstruisanje pomocu racunara



Modeliranje gredne konstrukcije

Aktivirati modul Static Structural (Model->Edit

- A
1

7 Static Structural

it IL{@ .;t,,,-l
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7 9 Results Transfer Data From New
Transfer Data To New
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#  Update
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/& Geometry
/> Coordinate Systems
/B Mesh
[=1--9[=] Static Structural (A5)
/7 Analysis Settings
El--9| Solution (A6)
(3] Solution Information

Details of "Model” 2
5 Fitex Optioms
Control [Enabled

Studijski program MaSinstvo — Konstruisanje pomoc¢u racunara

Lighting
Ambient [0.1 Y
Diffuse | 0.6

=
Specular |1
Color
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Modeliranje gredne konstrukcije

Podesiti veliCinu konacnog elementa na 0.2
generisati mrezu konacnih elemeneta

G A: Static Structural - Mechanical [ANSYS Multiphysics] — X
| File Edit View Units Tools Help || @ +% | “fSolve ~ ?/ShowErmors Tl W (8 4 [A] (@~ (PWorksheet ix
[ RAYE-R-ARARE @ SPRAAQIQREAAQAE NI E O | B show Vertices  gRWireframe | 7 <h) f A M Random Colors 5 Annotation Preferences

| WMEdgeColoring v £~ Aiv A~ Av A~ A Pl |-l Thicken Annotations
|Mesh =/ Update | @ Mesh v B Mesh Control v | |j1ic

Outline o
Filter: Name - 6]
@) Project

- (g Model (Ad)
/& Geometry

/T Analysis Settings
El--9| Solution (A6)
3] Solution Information

Details of "Mesh" n
= Defaults ~
Physics Preference | Mechanical
Relevance lo
=) sizing i

Use Advanced Size Function | Off

.
Element Size [020m >
i Ssembly

'smoothing | Medium ! 1 10.000 ()

Transition Fast .

Span Angle Center | Coarse

Minimum Edge Length  |3.0m _ _
| Infiation APrint Preview ) Report Preview/’ |
= [Datrh Canfarmina Onfinne v 2 x
Section Planes 2% Association Timestamp
] mExX»

No Messages No Selection Cels

|
L : : Y £ ADg D)o

Metric (m, kg, N, 5, V, A) Degrees rad/s
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Modeliranje gredne konstrukcije

Postaviti nepokretne oslonce

@ A Static Structural - Mechanical [ANSYS Muitiphysics]
| File Edit View Units Tools Help || @ =8 | “fSolve ~ ?/ShowErors 1l W [ 4 [A] [@]~ @ workheet ix

AV R- RO EOER &SSP AQEQ QALY " e | O | 5 Show Vertices g8 Wireframe | TjgShow Mesh & [l Random Colors () Annotation Preferences

| MEdgeColoring v £~ A~ A~ A~ A~ A I I Thicken Annotations

_\ Environment @k Inertial » @ Loads » @ Supports » @ Conditions + @,Dir:d FE~ B
Outline
Filter. Name >
(@] Project
= (@ Model (A4)
/B Geometry
2 Coordinate Systems
} Mesh
- 5[2] Static Structural (AS)
2 _,Z\ Analysis Settings
3, Fixed Support
3, Fixed Support 2
/B, Fixed Support 3
/3, Fixed Support 4
% Fixed Support 5 ‘
A8, Fixed Support 6
=7 Solution (A6) ‘
3] solution Information

Details of "Static Structural (A5)" b ‘ .’
= Definition
Physics Type [structural
inuvs]i Type Static Structural
Solver Target Mechanical APDL ’
=/ Options

b=

Environment Temperature |22, *C

Generate Input Only |No
0.000 5.000 10,000 )
2.500 - 7.500
Geometry A Print Preview ) Report Preview / |
Graph

Section Planes 3 x

EEER

| | Messages Graph |

‘ ‘ ‘-‘Q No Messages No Selection |Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius
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Modeliranje gredne konstrukcije

Zadati opterecenje

@ A : Static Structural - Mechanical [ANSYS Multiphysics]
“fSolve v ?/ShowEmors Tl W [ & [A) (@~ B workhest

| File Edit View Units Tools Help || @ =

s X
in

A TR VRO @ SR QAR E NS S

%[0~

‘ ' Show Vertices &% Wireframe | O ShowMesh & [l Random Colors 0 Annotation Preferences

| MEdgeColoring v £~ A~ A~ A~ A~ A I I Thicken Annotations

_\ Environment @ Inertial v @ Loads v @ Supports ¥ S, Conditions v @’Dimd FEv | B

/B Geometry

_,)‘\ Coordinate Systems
lesh

Py AN
3

@ Acceleration
@] Standard Earth Gravity
‘., Rotational Velocity

. Pipe Pressure
[ @ Force
@, Remote Force

[~ :j <} Solve
P
S R 2] Clear Generated Data
: 23‘ :x b Rename (F2)
e

@, Bearing Load
"] Bolt Pretension
©, Moment

[y

_1 Open Solver Files Directory

LW L ine Pressur

3] solution Information

Details of "Static Structural (A5)"

®] Thermal Condition
#] Pipe Temperature
4 Joint Load

@, Fluid Solid Interface

@, Fixed Support

@, Remote Displacement

Support

Delinlifion e @, Displacement
Physics Type Structural
Analysis Type Static Structural @ Fricti
Solver Target Mechanical APDL i

— @, Cylindrical Support
Options :

Environment Temperature |22, C ¥, Simply Supported
Generate Input Only |No @, Fived Rotation

@, Elastic Support

@, Constraint Equation
& Pipe |dealization

0.000 5.000 10.000 (m) I X

500 - 7.500

d @, Nodal Ori
&, Nodal Force

@, Nodal Pressure

@ Nodal Displacement
@ Nodal Rotation

@, EM Transducer
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Modeliranje gredne konstrukcije

Podesiti parametre opterecenje (intezitet i greda)

@ A : Static Structural - Mechanical [ANSYS Multiphysics]

| File Edit View Units Tools Help || @@ =i | <fSolve + ?/ShowErors {l W (] 4 [A) [@v @ Wor:he:
[PAYR-RAERE S STAQaQaEAAR a8 o O
| WMEdgeColoring v £~ A~ A~ A~ fv A || |]Thicken Annotations

\ Environment @ Inertial @ Loads v @ Supports v @, Conditions » @,Dired FEv B
Outline

s X
in

| P Show Vertices @B Wireframe | T Show Mesh & Il Random Colors 0 Annotation Preferences

Filter Name -
8] Project
= @] Model (A4)
-, Geometry
24 Coordinate Systems
. M Mesh
== Static Structural (AS5)
- _,7\ Analysis Settings
o A3, Fixed Support
- JB, Fixed Support 2
- JB, Fixed Suppoart 3
- JB, Fixed Support 4
o JB, Fixed Suppart 5
- A2, Fixed Support &

“er B, Line Pressure \
=-/|& Solution (A6)
¥ Solution Information
|Scoping Method | Geometry Selection
iGeametry |1 Edge
=1 Definition - ¥
| pe Line Pressure
| Define By Components
i Coordinate System | Global Coordinate System

X Component | 0. N/m (ramped)

-50090 W/, rampedy 2 0.000 5.000 10.000 (fm) z X
| Z Component |0, Nm (ramped)
| Suppressed |No 2500 7.500
Geometry A Print Preview) Report Preview/ ]
Graph R Tabular Data L3
Section Planes * x | [Steps [Time [s] [[¥ X [N/m] [[¥ ¥ [N/m] [ Z [N/m] [ A
I tinx & 11 Jo. 0. 0. 0.
I |\ Messages. Graph | 2l 0. -50000 0. 5
[ | |0 No Messages No Selection Metric (m, kg, N, 5V, A) Degrees rad/s Celsius 7

Studijski program Masinstvo — Konstruisanje pomocu racunara



Modeliranje gredne konstrukcije

Oslonci i opterecenje gredne konstrukcije

@ A : Static Structural - Mechanical [ANSYS Multiphysics] — X
| File Edit View Units Tools Help || @ =i | -/Sove = ?/ShowEmors 1l W [ & [A] (@~ @ workhest g
‘ oW Ry vl® [} DR & SLQAARlaqa@aaZmneagds imEs ‘ ' Show Vertices &% Wireframe |u’é5hawMah & B Random Colors /) Annotation Preferences

| WMEdgeColoring v £~ A~ A~ A~ A~ A Pl I+l Thicken Annotations
_\ Environment @ Inertial v @ Loads v Q‘Suppom ~ @ Conditions v @,Dimd FEv | B
Outline

a
Filter Name - iE]
5--9(=] Static Structural (A5) A~
] _,?_'\ Analysis Settings
/3, Fixed Support
/3, Fixed Support 2
- 3, Fixed Support 3
/B, Fixed Support 4
- B, Fixed Support 5
3, Fixed Support &
i B, Line Pressure
/B, Line Pressure 2
/B Line Pressure 3
| l, Line Pressure 4
/B Line Pressure 5
: L, Line Pressure 6 u
7% Line Pressure 7 [ Line Pressure 3: 50000 N/m
57 Solution (A5) - Line Pressure 4 50000 M/m

l] Solution Information
v

Details of "Static Structural (A5)" 3
[=I Definition

Physics Type [Strucural

Analysis Type | Static Structural

Solver Target | Mechanical APDL B
=] Options B D

| Environment Temperature |22, °C
iGenerate Input Only |No

0.000 5.000 10.000 () z X
2.500 g 7.500

Geometry A Print Preview ) Report Preview / |

Graph b3

Section Planes 2 x .
EFEETS

| | Messages Graph | 1%

‘ ‘ ;0 No Messages 1 Edge Selected: Length = 6. m |Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius 7
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Modeliranje gredne konstrukcije

|zabrati analizu pomjeranja

@A : Static Structural - Mechanical [ANSYS Multiphysics] — X
| File Edit View Units Tools Help || @ =i | -/Sove = ?/ShowEmors 1l W [ & [A] (@~ @ workhest g

| ® % W G @‘@ DR e SLQa a@AETrda ©| O | 5 Show Vertices g8 Wireframe | TjgShow Mesh & [l Random Colors () Annotation Preferences
| WMEdgeColoring v £~ A~ A~ A~ A~ A |l |1 Thicken Annotations

_\Snlmion ’., Deformation v %Strain - q,Strss v ‘= Energy v ‘ ‘, Damage v \ \the v, @Tﬂo&s v E.User Defined Result \ Ee] Campbell Diagram ‘eCuordinm Systems v ', Beam Results v [F:

Filter: Name -
£--9(=] Static Structural (A5)
7 Analysis Settings
/3, Fixed Support
/3, Fixed Support 2
/3, Fixed Support 3
/3, Fixed Support 4
/3, Fixed support 5
3, Fixed Support &
i B, Line Pressure
/B, Line pressure 2

s
?
!

Deformation
5 - " <} Solve Contact Tool

Do SRR 4 Evaluste All Results R

=) Adaptive Mesh Refinen Prebe

Max Refinement Loops 11_- ] Clear Generated Data
Refinement Depth |2. | alb Rename (F2)

=l Information , ) . Beam Results » .
status [So A Open Solver Files Directory

Coordinate Systems %

Beam Tool L4

@, User Defined Result

B Commands 0.000 5,000 10,000 () e X
L EE— [ ESSSS—
2500 7500

Geometry A Print Preview ) Report Preview /

Graph 2 Tabular Data i
Section Planes o x ~
EEER
| | Messages Graph | v
‘ ‘ 0 No Messages 1 Edge Selected: Length |Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius 4
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Modeliranje gredne konstrukcije

|zabrati alat za analizu grednih konstrukcija

@ A Static Structural - Mechanical [ANSYS Muitiphysics] - X
| File Edit View Units Tools Help || @ =i | =fSove = 2/ShowErrors 1l W (8] & [A) [@~ @ workshest i

| ® ' R R @@ DR &S S+Qaea@aofmnages o O | P Show Vertices gRWireframe | TjShow Mesh & Il Random Colors () Annotation Preferences
| WMEdgeColoring v £~ A~ A~ A~ A~ A || |1 Thicken Annotations

_\Snlmian ’.,Defnn'nation v %Strain - %Strss v ‘= Energy v ‘ ‘a Damage v \ \the v, @Tuafs v E.User[)eﬁned Result \ Ee] Campbell Diagram ‘eCuordinmSynsns v ‘,Bzam Results v [

Filter Name -
i _,Z\ Analysis Settings A
|-/, Fixed Support
- /3, Fixed Support 2
1B, Fixed Support 3
1+ A%, Fixed Support 4
1B, Fixed Support §

1, Fixed Support &

1 P, Line Pressure

i /B Line Pressure 2

i l, Line Pressure 3

/B Line Pressure 4

| %, Line Pressure §
/%, Line Pressure 6

Deformation

BT Sotve Contact Toal » -
Details 6 “Soiution (A6)" </ Evaluate All Results Probe 5
5| At Ml Rl 4] CearGeneratod Dot Coordinate Systems 4
Max Refinement Loops || &b Rename (F2) _—
Refinement Depth |= 3 N Beam Results »
4 Open Solver Files Directory v

§

Status [Sowe Requirea T T ;N

@, User Defined Result

B Commands
0.000 5.000 10.000 (m) I X
L EE— [ ESSSS—
2.500 7.500

Geometry A Print Preview ) Report Preview / |

Graph 2 Tabular Data i
Section Planes 3 x
EEER
| | Messages Graph |

|8 No Messages No Selection |Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius 4
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Modeliranje gredne konstrukcije

Aktivirati rjesavanje problema

@ A Static Structural - Mechanical [ANSYS Multiphysics]
| File Edit View Units Tools Help || @ =48 | <fSolve w ?/ShowErors T ¢ [0 4 [A] [@]v @ worheer in
[ BAYR-"ERAROE &S PAQAQAQa@AQAE NS E Q| O | P Show Vertices g8 Wireframe | T Show Mesh & Il Random Colors () Annotation Preferences
| WMEdgeColoring v £~ A~ A~ A~ fiv A || |]Thicken Annotations

\Snluhan %Defmmation b ogStrain - q,Strss - '; Energy v \ ',, Damage v \ Q\the - @Tuo!s -

- X

Coordinate Systems v @ Beam Results v [

@, User Defined Result | 5= Cornpbell Disgram | @y

| Filter:  Name >
tee A8, Fixed Support ~
- JB, Fixed Support 2

- JB, Fixed Support 3

- JB, Fixed Support 4

o JB, Fixed Support 5

- JB, Fixed Suppart &

1 ,/O' Line Pressure

o /B, Line Pressure 2 7

o ,/9' Line Pressure 3

/P, Line Pressure 4

B, Line Pressure § 1 ) .
/P, Line Pressure §

9%, Line Pressure 7

o
L Insert L4
ve
<} Evaluate All Results -
Details of "Solution (A8)" | | Clear Data
1| Adaptive Mesh Refinemd ¢; Rename (F2)
Max Refi Loops ‘ . § §
Refinement Depth 3 Open Solver Files Directory
=) Information ) | i
Status | Solve Required ‘
0.000 5.000 10.000 (rm) z X
[ —EEaaa—— [ ESS——
2,500 7.500
ry A Print Preview\ Report Preview/ ]
Graph 7
Section Planes 2 x ~
EEEXS
| ] Messages. Graph | v
‘ ‘ ‘-VQ\ No Messages No Selection |Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius 4
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Modeliranje gredne konstrukcije

Pomjeranja konstrukcije

@ A Static Structural - Mechanical [ANSYS Multiphysics] — pe
| File Edit View Units Tools Help || & = | s/Sove = ?/ShowErors tfl W (] 4 [A] [@~ @ worheet g

["Ah T R-REME S s Qa QR M & |0~ | 5’ Show Vertices gRWireframe | “; “howtiech A Il Random Colors <@ Annotation Preferences
| WMEdgeColoring v £~ A~ A~ A~ fv A || |]Thicken Annotations
| Result 31 (Auto Scale) - @~ BE~®~ 3 | @ @ | EProbe | Display Al Bodies -
| Fiter:  Name -
tee A8, Fixed Support -~

- JB, Fixed Support 2
- JB, Fixed Support 3
- JB, Fixed Support 4
o JB, Fixed Support 5
- JB, Fixed Suppart &
1 'ﬁ- Line Pressure
o /B, Line Pressure 2
o 'ﬁ- Line Pressure 3
/P, Line Pressure 4
: ﬂ. Line Pressure §
'« Line Pressure &
'ﬁ' Line Pressure 7
=/ Solution (A6)

- /1] Solution
i fo

e
0.0061048
0.0036979
0.0012911 Min

v
Details of “Total Deformation”
= Scope IPS ¥
Scoping Method | Geometry Selection
Geometry |1 Edge
(=] VDeﬁnmon
Type Total Deformation X
By Time
Display Time Last
Calculate Time Histary | Yes
Identifier - —
i N y A Print Preview ) Report Preview/ ]
[~/ Results
Minimum [1.2911e003 m
Maximum |2,2952=~Dﬂ1 m
=1 Minimiim Valie Ouer Time
Section Planes
EEEE

‘ ‘ ‘poJ No Messages No Selection |Metric (m, kg, N, 5, V, A) Degrees rad/s Celsius 4
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Modeliranje gredne konstrukcije

Aksijalni naponi konstrukcije (Beam Tool->Direct

Stress

() A : Static Structural - Mechanical [ANSYS Muitiphysics] — X
| File Edit View Units Tools Help || @ = | s/Sove = ?/ShowErors tfl W [ 4 [A] [@~ @ workheet g
[BARrYEI--OORDB @St aQaaeEaaExnga s | O | 7 show Vertices gQWireframe | ' <hiow e A W Rendom Colors (2 Annotation Preferences

| M EdgeColoring v £~ A~ A~ A~ A~ A Pl |+l Thicken Annotations
| Result 31 (Auto Scale) ~ @~ E-®~ 7 | @ | @Probe | Display

All Bodies -

Filter Name -
o fB, Fixed Support 4
- M3, Fixed Support 5
- A%, Fixed Suppart &
P ﬁ\( Line Pressure
- ﬁ. Line Pressure 2
- ﬁ, Line Pressure 3
o /B, Line Pressure 4
- ﬁ, Line Pressure 5
f ﬁ. Line Pressure &
- ﬁ, Line Pressure 7
=/ Solution (A6)
- /3] Solution Information
- /& Total Deformation
&,/ Beam Tool
e
L. MR Minimum Combined Siress
e M8 Maximum Combined Stress

Details of "Direct Stress”

(=]

Definition

Type
By

" Display Time
Calculate Time History

liiiutt Stress
Time

Yes

Identifier
Suppressed

No

=] Integration Point Resu

= Results

lts

Display Option [Averaged

Geometry A Print Preview ) Report Preview/

| Minimum | 8.5879¢-007 Pa

Maximum

| 1.7497e+006 Pa

Minimuim

|
=

=] Value Over Time
|

[ # sa700-0n7 P2
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Modeliranje gredne konstrukcije

Kombinocija aksijalnog napona i maksimalnog
napona savijanja konstrukcije (Beam Tool-
>Maximum Combined Stress)

Studijski program MaSinstvo — Konstruisanje pomocu rac":unara_



